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  Important Notice 

Important Notice 
This guide is subject to the following conditions and restrictions: 

This User's Guide provides documentation for the PowerTerm® Series of 
products. Your specific PowerTerm LTC product might include only a portion 
of the features documented in this Guide. 

The proprietary information belonging to Ericom® Software is supplied 
solely for the purpose of assisting explicitly and properly authorized users of 
PowerTerm®. 

No part of its contents may be used for any other purpose, disclosed to any 
person or firm, or reproduced by any means, electronic and mechanical, 
without the express prior written permission of Ericom® Software. 

The text and graphics are for the purpose of illustration and reference only. 
The specifications on which they are based are subject to change without 
notice. 

The software described in this document is furnished under a license 
agreement. The software may be used or copied only in accordance with the 
terms of that agreement. 

Information in this document is subject to change without notice. Corporate 
and individual names and data used in examples herein are fictitious unless 
otherwise noted. 

 

Copyright© 1994 – 2005 Ericom® Software 

Ericom® and PowerTerm® are registered trademarks of Ericom® Software, 
which may be registered in certain jurisdictions. Other company and brand, 
product and service names are trademarks or registered trademarks of their 
respective holders. 
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  About this Guide 

About this Guide 
PowerTerm LTC is a fully functional terminal emulator for Linux Thin Clients 
platforms. 

This Guide assumes that you are familiar with basic windowing system 
conventions (file transferring, copy/paste functions, etc.) and the operation 
of the terminal you intend to emulate. 

The PowerTerm LTC User's Guide is comprised of the following chapters: 

Chp.  1 Introduction Presents 
PowerTerm 
LTC and its 
main features. 
It also 
describes how 
to get 
PowerTerm 
LTC started. 

Pg. 7

Chp.  2 PowerTerm 
LTC: General 
Reference

Describes the 
PowerTerm 
LTC window, 
the menus 
and the 
different 
dialogs. 

Pg. 12

Chp.  3 Starting and 
Stopping 
Sessions

Describes how 
you start and 
stop sessions, 
and customize 
them. 

Pg. 62

Chp.  4 Defining 
Emulations

Describes how 
to configure 
and customize 
emulations 
parameters.  

Pg. 67

Chp.  5 Defining 
Connections

Describes how 
to configure 
connections 
and save 
them. 

Pg. 70

Chp.  6 Manipulating 
the Desktop 
and Selecting 
Text

Explains how 
you can 
customize the 
Desktop 

Pg. 74
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  About this Guide 

display and 
how to select 
text in 
different ways. 

Chp.  7 Keyboard 
Settings

Describes how 
to customize 
and map your 
keyboard. 

Pg. 81

Chp.  8 Soft Buttons Explains how 
to customize 
the Soft 
Buttons. 

Pg. 87  

Chp.  9 Printing Explains how 
to define 
printing 
parameters. 

Pg. 88

Chp.  10 Scripts Explains how 
to work with 
the 
PowerTerm 
Scrip 
Language 
(PSL). 

Pg. 92
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  Introduction 

1 Introduction 
This chapter presents PowerTerm LTC and its main features. It also 
describes the basic steps on how to use PowerTerm LTC for users who are 
familiar with accessing remote terminals.  

This chapter includes the following topics: 

• What is PowerTerm LTC? 

• PowerTerm LTC Features 

• System Requirements 

• Getting Started 

1.1 What is PowerTerm LTC? 
PowerTerm LTC is a fully functional emulator for Linux Thin Clients operating 
systems. It emulates various terminal types, including IBM, UNIX, HP, VMS 
and Tandem. PowerTerm LTC enables you to connect to a single or to 
multiple hosts via both network and remote connections.  

PowerTerm LTC has two main features to enable the LTC to act and feel like 
a real host terminal: 

• Terminal display emulation, PowerTerm LTC emulates the exact display of the 
chosen terminal. It presents host applications precisely as they would 
appear on the terminal. Once the LTC connects to a host computer, all host 
operations can be performed as if the LTC is an actual host terminal. 

• Terminal keyboard emulation, PowerTerm LTC enables you to emulate the 
selected terminal's keyboard by mapping the LTC keys to match the host 
keys. Keyboard mapping definitions are stored in a .ptk file. 

PowerTerm LTC also provides various options to customize and optimize the 
working environment such as: 

• Soft buttons, programmable buttons located at the bottom of the PowerTerm 
LTC window. 

• PowerTerm Script Language (PSL), a full-featured programming language, 
which enables you to create scripts for automating tasks. For example, you 
can create a PSL script for automatic login. Scripts can be used at startup of 
PowerTerm LTC, or can be utilized any time during a PowerTerm LTC 
session. PSL commands can also be assigned to the Soft buttons to enable 
additional functions with a click of the mouse. 

1.2 PowerTerm LTC Features 
PowerTerm LTC features include: 

• Compact, light and high performance program 
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• Supports TCP/IP  

• Supports RS-232  

• Supports Ethernet and Token ring networks. 

• PowerTerm Script Language (PSL) 

• String functions, including sub-string, index and concatenation 

• Enables you to save parameters for all sessions 

• High-level API enables access from other environments, such as C++, Visual 
Basic, and Power Builder. Also supports EHLLAPI. 

• Language support for most Western and Eastern European languages 

• Modem dialling 

• Multi-session capabilities 

• User programmable Soft buttons 

• Control of color selection and screen attributes 

• Supports printing including Auto Print mode and Slave Printing. Also 
supports Advanced Printing capabilities, including TN5250 Host Print 
Transform, specifying the orientation of the printed output for non-graphic 
printing, setting values for CPI/LPI/FONT parameters, printer rows and 
columns. 

• Easy to use keyboard mapping 

1.3 Getting Started 
1.3.1 PowerTerm LTC Setup 

To enable LTC-host interactions, you need to define two sets of parameters: 

• Terminal parameters 

• Communication parameters 

All parameters are saved in a Terminal setup file where the default is called 
ptdef.*. Setup file extensions are: 

• pts for the Terminal setup file 

• ptc for the Communication setup file 

• ptk for the Keyboard definitions file 

PowerTerm LTC provides the option to work with a single host or with 
multiple hosts. You can create different setup configurations for working with 
each host to enable each user a customized working environment. (For more 
information about specifying and saving parameters, see chapters Defining 
Emulations and Defining Connections.) 
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Working with a Single Terminal Connection 
If you only need to connect to a single host connection, you should use the 
default terminal setup and communication file. PowerTerm LTC automatically 
uses the parameters in the setup file to start the system. 

Working with Multiple Terminal Connections 
If you are working with multiple terminal connections, you may need to use 
a different setup file for each emulation. To create a setup file, you first need 
to define the terminal setup and communication parameters, and then save 
these parameters to a terminal setup file. 

1.3.2 A Quick Guide through PowerTerm LTC 

 

Step 1: Start PowerTerm LTC 
Launch PowerTerm LTC. 

 When PowerTerm LTC is used for the first time, the PowerTerm LTC 
window is automatically displayed together with the Connect dialog. After 
the connection parameters have been defined, the Connect dialog will be 
displayed according to your selected option. 
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PowerTerm LTC opens with the default terminal setup file. You can also open 
PowerTerm LTC using a customized setup file, or script. 

The most important feature of the PowerTerm LTC window is its work area, 
which emulates a host terminal screen by displaying data entered on your 
terminal data received from the host. (For more information on how to 
customize your desktop, see chapter Manipulating the Desktop and Selecting 
Text) 

Step 2: Select a Terminal Emulation 
You can either select a terminal type for the current session or open a 
previously defined terminal setup file. 

 To select terminal settings: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. 

3. Click one of the Terminal Types. The emulation type that you select changes 
the number of setup tabs and, for IBM emulations, the PowerTerm LTC 
windows display. 

4. Define terminal settings by clicking the relevant Property page tab and define 
setup parameters. 

5. Click OK. 

6. Save the settings by selecting File | Save Terminal Setup or Save Terminal 
Setup As. The file is saved. 

 To open a previously defined Terminal setup file: 

1. Select File | Open Terminal Setup. The Open File dialog appears. 

2. Select your desired setup file and click OK. 

Or, 

1. Select Communication | Connect. The Connect dialog appears. 

2. Type your desired setup file name in the Setup File field or alternatively click 
the browse button and select the desired file in the Select File dialog. 

Step 3: Connect to Host 
After you have selected a terminal emulation, you need to define 
communication parameters for the current session, or select a previously 
saved session from the session list. PowerTerm LTC also provides an option 
to run a script file before you connect to a host. 

 To connect to a host: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Define communication parameters or select a session with previously defined 
connection parameters from the Session list. 

3. Click Connect. A connection is established to a host computer. 
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Step 4: Work with the Host 
Once you have connected to a host, PowerTerm LTC enables you to work as 
if you are working from a terminal. 

PowerTerm LTC enables you to define print parameters, and print the 
terminal screen or data transferred from the host application. 

Step 5: Exit PowerTerm LTC 
PowerTerm LTC provides different options when exiting PowerTerm LTC. You 
can end a session automatically or be prompted with a confirmation 
message prior to closing a session. 

• Select File | Exit or press both <Alt> and <X> on the keyboard. 
If you have changed terminal settings to Confirm Save in the Terminal Setup 
dialog/Preference tab, PowerTerm LTC displays a warning message asking if 
you want to update the terminal settings file. The message will point to the 
name of the setup file currently loaded (ptdef.pts, if you use the default 
settings). Click OK to update the terminal settings, or No to cancel the latest 
changes and restore the default setup. 
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2 PowerTerm LTC: General Reference 

2.1 The PowerTerm LTC Window 

 

The following is a list of the PowerTerm LTC window components as they 
appear from top to bottom. You can configure all the components, except 
the work area, to be displayed or hidden as will be convenient for you. 

 

Control Menu Box Provides standard commands. 

Title Bar Displays the application name. 
During a communication 
session, the Session type 
and/or host name is displayed 
next to the application name, 
for example, (A) PowerTerm 
LTC. 

Minimize button Closes the window, but not 
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PowerTerm LTC. 

• Click the PowerTerm LTC icon 
appearing in the Taskbar to 
reopen the PowerTerm LTC 
window. 

Maximize button Enlarges the window so that if 
fills the entire screen. The 
button is then replaced with the 
Restore button. This button is 
used to restore the window to 
its previous size. 

Menu Bar Contains dropdown menus, 
which enable the user to 
perform most PowerTerm LTC 
operations. 

Toolbar Contains icons, which can be 
used as shortcuts to access 
frequently used menu 
commands. 

Work Area Displays the data entered on 
the LTC terminal or received 
from the host. During an 
emulation session, this work 
area emulates a terminal 
display. For IBM terminal types, 
the background of the work 
area is displayed in black. 

History Scroll Bar For non-IBM emulations only. 

Enables you to scroll up and 
down through the PowerTerm 
LTC window to view previously 
displayed data. Default: 
displayed. 

Soft Buttons Contains a series of buttons 
displayed above the Status bar 
that you can program to 
execute specific script 
commands. 
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Emulator Type Displays the current terminal 
emulation type selected from 
the Emulation tab in the 
Terminal Setup dialog. 

Cursor Position Counter Displays the current line and 
column position of the text 
cursor in the work area. 

Caps Indicates whether the keyboard 
is in Caps lock mode. 

Hold Indicates whether the screen is 
in hold or frozen mode. 

Status Indicator – On Line, 
Off Line, Printer, Auto Prt 

• The status indicator reads On 
Line when communication is 
established. 

• The indicator reads Printer 
when data is transmitted with a 
printing request to the slave 
printer. The color of the 
indicator is the same as when 
PowerTerm LTC is in On Line 
mode, for example, the printer 
will appear in red if the system 
was On Line when the printing 
request arrived. 

• The data is sent to the screen 
and printer, and the indicator 
reads Auto Prt, when the 
terminal is in Automatic Printing 
mode. 

Macro/Message Display Area Displays system messages or a 
script sequence, as you type it 
in the work area. 

Window border and corners Changes the size of the 
window. The characters that 
appear in the work area are 
scaled up or down so that all 
the information always remains 
in view. 
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2.2 Menu Bar 
The PowerTerm LTC Menu bar displays the main PowerTerm LTC functions in 
dropdown menus. The following is a brief description of each menu and the 
functions that it can perform.  

2.2.1 File Menu 
The File menu provides options to create, save and restore a terminal setup 
file, as well as open keyboard settings and save them. You can also use this 
menu to set printing parameters, print, and to open a new instance of the 
PowerTerm LTC window. 

New Terminal Setup Restores the default parameters 
including the terminal display 
colors. If you have changed 
terminal parameters since the 
last save, PowerTerm LTC 
displays a warning message 
asking whether or not to save 
the latest changes. The 
message point to the terminal 
settings file currently loaded. 

Open Terminal Setup Opens the Open File dialog, 
which enables you to select and 
open an existing setup file. 

Save Terminal Setup Saves both terminal setup and 
communication parameters to 
the current setup file. 

Save Terminal Setup As Opens the Save File As dialog, 
which enables you to save the 
current setup configuration 
under a different name. 

Open Keyboard File Opens the Open Keyboard File 
dialog, which enables you to 
open keyboard mapping 
settings that have previously 
been saved. 

Save Keyboard file Opens the Save Keyboard File 
dialog, which enables you to 
save separate keyboard 
mapping settings in a separate 
file and open them at a later 
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date. 

Print Screen Prints the contents of the work 
area, or the selected text. 

Print Setup Displays the Print Setup dialog, 
which contains printing 
parameters. Displayed 
parameters change according to 
the printer you selected. 

• The Default Printer parameter 
enables you to send the output 
to the default printer selected. 

• The Specific Printer parameter 
allows you to select one of the 
currently installed printers. 

Start/Stop Auto Print Prints all the data displayed in 
the work area. This option 
toggles between Start and Stop 
Auto Print. 

Close Print Queue Closes the print queue 
manually. 

Form Feed Executes a form feed on the 
printer. 

Line Feed Executes a line feed on the 
printer. 

New Terminal Window Opens a new instance of the 
PowerTerm LTC window. This 
enables you to run several 
sessions concurrently and 
simulate more than one 
terminal type. You can access a 
session by switching windows. 
After opening a new terminal 
window, you should define 
terminal and communication 
parameters before connecting 
to a host. 

Exit Exits the current PowerTerm 
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LTC session. 

2.2.2 Edit Menu 
The Edit menu provides options to select, clear, and reverse text in the 
PowerTerm LTC window and delete the contents of the history buffer. The 
Edit menu also provides standard editing commands (e.g. cut/copy/paste), 
in addition to commands that enable you to copy data to a file and copy data 
automatically to the clipboard. 

Select Screen Selects the contents of the 
entire work area. 

Clear Screen Captures the entire PowerTerm 
LTC screen and passes the data 
to the history buffer. 

Clear History Deletes the entire contents of 
the history or scroll back buffer. 
This command is only available 
when the history buffer is in 
use. 

Reverse Screen For RTL languages only. 

Reverses the screen so that you 
can type from left to right or 
right to left, depending on the 
language you use. 

Cut Cuts the selected text and 
places it on the clipboard. 

Copy Copies marked text to the 
clipboard when the Automatic 
Copy option in the Edit menu is 
not active.  

Paste Pastes the clipboard contents 
into the work area. Right-click 
sends data stored on the 
clipboard to the host. 
Equivalent to actually typing 
the contents of the clipboard on 
the host screen. 
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Copy to File Copies selected information to a 
file. If no text is selected, the 
entire screen is written to the 
file. 

Automatic Copy Automatically copies selected 
text to the clipboard with no 
need to select the Copy option. 

Copy Right to Left For RTL languages only. 

Reverses the order of the 
letters in the work that was 
copied to the clipboard when 
displayed. 

2.2.3 Terminal Menu 
The Terminal menu provides options to define and reset connection 
parameters, set the system to be online or offline, and freeze or unfreeze 
the screen. You can also select the fonts and languages (in versions that 
support it) to be displayed in the PowerTerm LTC window. 

Setup Opens the Terminal Setup 
dialog in which you can define 
settings for terminal emulation. 
This dialog contains different 
tab pages that enable you to 
define all aspects of your 
terminal setup. 

PowerTerm Fonts Displays the default PowerTerm 
LTC fonts. These fonts are 
scaleable so that if the window 
shrinks, the fonts will shrink in 
relation to the size of the 
window. 

System Fonts Displays the PowerTerm LTC 
window with system fonts. 
These fonts remain the same 
size, no matter what the size of 
the window. 

Reset Resets the VT terminal defaults. 
This command does not apply 
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to PowerTerm LTC's exclusive 
terminal parameters (such as 
color). 

Online Sets the system to be online or 
offline. 

Hold Screen Stops communication and 
freezes the screen. To unfreeze 
the screen, reselect the 
command. 

Language option Selects the user interface 
language to appear in English, 
German, French, Italian, or 
Spanish. 

2.2.4 Communication Menu 
The Communication menu provides options to define and modify the 
communication (session) parameters, and to connect/disconnect a 
communication session. 

Connect Displays the Connect dialog, 
which enables you to define 
session parameters and connect 
to a host. 

Modify Connection Displays the Connect dialog, 
which enables you to modify 
connection parameters for COM 
type communication. 

Disconnect Disconnects the communication 
session. 

Reset Communication Resets the communication port 
for COM type communication. 

SSL Setup Sets the SSL security. 

Kerberos Manager Allows you to configure 
advanced Kerberos parameters 
and to perform advanced 
Kerberos actions. 
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Utilities Displays signal options: 

Break, sends a break for COM 
type communication. Equivalent 
to <Ctrl>+<Break>. 

AUX: Modify Connection, enables 
two-way slave printing to a serial 
printer. 

2.2.5 Options Menu 
The Options menu enables you to map your keyboard and define the work 
area display. It also enables you to store a session in a log file as well as 
provides options to customize your PowerTerm LTC screen. 

Keyboard Map Displays the Keyboard Mapping 
dialog, which enables you to 
map your LTC keys to host keys 
on the terminal keyboard. 

Start/Stop Trace Stores received data in the 
Trace.log and Capture.log files. 
These files are located in the 
PowerTerm LTC folder. The 
menu command toggles 
between Start Trace and Stop 
Trace. 

Capture.log stores raw data, as 
received from the host. 

Trace.log stores formatted data 
with readable escape 
sequences.  

Input Trace Runs the contents of the 
Capture.log file, as if it were 
received from the host, and 
views the contents on the 
PowerTerm LTC desktop work 
area. 

Hide Menu Hides the Menu bar. 

Hide/Show Tool Bar Hides/Shows the Toolbar. 
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Hide/Show Buttons Hides/Shows the Soft buttons. 

Hide/Show Status Bar Hides/Shows the Status Bar. 

2.2.6 Script Menu 
The Script menu provides options to create and run PSL commands. 

Run Script Displays the Run Script dialog, 
which enables you to select and 
run a script. 

Script Command Displays the Script Command 
dialog, which enables you to 
run individual script commands. 

Start/Stop Script Recording Records a script automatically. 
After requesting Start Script 
Recording, the manual 
operations you perform in the 
emulation screen are recorded 
into a script file until you 
choose the Pause or Stop Script 
Recording command. 

Pause/Continue Script 
Recording 

Pauses or resumes the script 
recording. This enables you to 
exclude certain operations from 
recording. 

Activate Recorded Script Activates the script currently 
recorded in memory. The script 
is saved in memory while the 
PowerTerm LTC session is 
active. 

Save Recorded Script Enables you to save a script 
from memory to a specific file 
to be used at a later date. 

2.2.7 Help Menu 
The Help menu provides options for accessing the PowerTerm LTC online 
help and product and license management information. 
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Contents Accesses the online help. 

About PowerTerm LTC Displays product and contact 
information. 

2.3 Toolbar 
The PowerTerm LTC Toolbar contains icons, which provide shortcuts to 
frequently used menu options. The following is a brief description of the 
icons. You can also place the cursor over the icon to display its description 
as a tool tip. 

Hold 
Screen/Release 
Hold  

 
For non-IBM emulations 
only. 

Suspends and resumes 
communication with the 
host. After you click the 
Hold Screen icon, it turns 
red. After you click the icon 
again, it changes back to 
green and update of the 
PowerTerm LTC window 
resumes. 

Equivalent to Terminal | 
Hold Screen. 

New Terminal 
Window  

Opens a new instance 
(window) of PowerTerm 
LTC. 

Connect/Disconnect 
 

Opens the Connect dialog 
where you define session 
communication parameters 
and connect to the host.  

Disconnects an open 
session. 

Equivalent to 
Communication | Connect 
(Disconnect) 

Cut  
 

For IBM 5250 emulations 
only. 
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Cuts the selected text. 

Equivalent to Edit | Cut. 

Copy to Clipboard  
 

Copies the selected data 
displayed in the work area 
to the clipboard. 

Equivalent to Edit | Copy. 

Paste from 
Clipboard  

Pastes data from the 
clipboard to the host 
application. 

Equivalent to Edit | Paste. 

Print Screen 
 

Prints selected text from 
the history buffer or the 
entire contents of the work 
area. 

Equivalent to File | Print 
Screen. 

Start/Stop Auto 
Print  

For non-IBM emulations 
only. 

Prints incoming data as it is 
displayed on the screen. 
Click the icon again and the 
automatic printing stops. 

Equivalent to File | Start 
Auto Print. 

Start/Stop Script 
Recording  

Records manual operations 
in script form. Click the 
icon again and the script 
recording stops. 

Equivalent to Script | Start 
Script Recording. 

Change to 80 
Columns  

For non-IBM emulations 
only. 

Specifies an 80-column 
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display for the work area. 

Equivalent to Terminal | 
Setup | Display. 

Change to 132 
Columns  

For non-IBM emulations 
only. 

Specifies a 132-column 
display for the work area. 

Equivalent to Terminal | 
Setup | Display. 

Terminal Setup 
 

Displays the Terminal 
Setup dialog in which you 
can define terminal setup 
parameters. 

Equivalent to Terminal | 
Setup. 

Keyboard Mapping 
 

Opens the Keyboard 
Mapping dialog in which 
you can map LTC keys to 
host keys. 

Help Contents 
 

Displays product 
information. 

Equivalent to Help | 
Contents. (On request: 
Displays the PowerTerm 
LTC online help.) 

2.4 Hot Keys 
Hot keys are keyboard shortcuts that you can use instead of selecting menu 
commands. These hot keys refer to your standard LTC keyboard keys, before 
they are mapped to terminal keys. Once hot keys are mapped, they lose 
their original function and reflect the newly mapped terminal key. For 
example, if you map <Alt F4> to the <Backspace> key on the terminal 
keyboard, it performs the function of a <Backspace> key. 

The following table lists the default PowerTerm LTC hot keys: 

Alt F4 Exit 
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Alt F6 Open a new terminal window 

Alt F9 Activate script 

Ctrl+Alt+F9 Start/Stop script recording 

Ctrl+Shift+P Activate recorded script 

Alt F10 Select screen 

Alt F11 Clear screen 

Alt F12 Reverse screen. 

IBM 5250 emulations not 
included. 

Scroll Lock Hold screen 

Pause Change the cursor shape 

Ctrl Up Arrow Scroll up one line 

Ctrl Down Arrow Scroll down one line 

Ctrl Home Scroll to the beginning of the 
history buffer 

Ctrl End Scroll to the end of the history 
buffer 

Ctrl Page Up Scroll up one page 

Ctrl Page Down Scroll down one page 

Shift+Ctrl+X Switch focus to session X 

X is the session letter (A…Z) 
displayed in the PowerTerm LTC 
windows Title bar. 
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Ctrl+Spacebar Switch to next active session 

2.5 Connection Dialog 
 The parameter options change according to emulation and Session Type 

(protocol) selected.  

 

 

Session Type Parameters 

TELNET Uses the Telnet protocol over 
TCP/IP for network 
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communication. 

• Specify the host computer 
name or the IP address in the 
Host Name text box. 

• Specify the TELNET Port number 
(default 23). 

COM Uses serial communication with 
the device's COM ports. 

• Define the Baud Rate, Port 
Number, Parity, Stop Bits and 
Flow Control 

• Optionally, specify a telephone 
(Dial) number. 

TN3270 TELNET for 3270 emulations. 

• Select Use TN3270 Protocol if 
you want to work with TELNET 
SNA extensions. 

• Specify the LU Name of the host 
(LU name or LU pool). 

TN5250 TELNET for 5250 emulations. 

2.6 Terminal Setup Dialog 
 The emulation type that you select changes the tabs (property pages) 

displayed in the Terminal Setup dialog and their options. 
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Property Page Description 

Emulation Displays supported terminal 
emulations and enables you to 
select a terminal type. 

General Defines parameters for the 
terminal emulation type. 

Display Defines display settings for the 
PowerTerm LTC window. 

Keyboard Defines keyboard setup 
parameters. 

Printer Defines printer parameters. 

Tabs Defines tab stops in the work 
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area. 

Colors Defines color settings for the 
PowerTerm LTC window. 

Preferences Defines parameters that 
determine PowerTerm LTC 
behavior and automate 
processes. 

2.6.1 General Property Page 

Non-IBM Emulations 

 

 

Option Description 

Terminal ID Determines the ID returned by 
the emulation program to the 
host. Verify that you select an 
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ID that the host 
application/system recognizes. 

NRC Set Determines the communication 
and keyboard character set for 
7-bit data only.  

UPS Set Determines the communication 
and keyboard character set for 
8-bit data only. 

8 bit Controls Enables when UPS Set is 
specified as Code Page 437 and 
up.  

Disable, determines if 0x80 to 
0xAF are displayed characters. 

Enable, determines if 0x80 to 
0xAD are control characters. 

0x9B, all characters are 
displayed characters except 
0x9B, which is a control 
character. 

Online Equivalent to Terminal | On Line 
(Off Line). 

New Line Determines whether the 
<Enter> key generates only a 
carriage return or a carriage 
return/line feed combination. 

Use 8 Bit Data Characters Select this parameter if the 
communicated data is in 8-bit 
character format. Clear it for 7-
bit characters. When cleared, 
the 8th bit is truncated. If you 
receive 7-bit data, you can 
convert it to 8-bit data for 
printing on the slave printer. 

CR->CRLF Adds a line feed after each 
single carriage return (one that 
has no line feed following it) 
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when in slave printing mode. 

User Defined Keys (UDK) Determines whether 
applications on the host system 
can override your user-defined 
keys (UDKs) when you have 
defined a function key that 
conflicts with how the host 
wants to use this key. UDKs let 
you use a single key for 
multiple keystrokes. To 
program the 15 UDKs, 256 
bytes are available. The key 
definitions are loaded 
sequentially (from F6 to F20) so 
that if you reach the 256-byte 
limit, more definitions cannot 
be loaded. 

Locked, prevents UDKs from 
being overridden. 

Unlocked, allows UDKs to be 
overridden. 

Cursor Keys Determines the behavior of the 
four arrow keys. 

Normal, generates ANSI-
standard control sequences for 
moving the cursor. 

Application, generates 
customized application program 
functions. 

Keypad For VT emulations only. 

Determines the effects of the 
numeric keypad on your 
keyboard. 

Numeric, keypad keys insert 
numbers. For example, pressing 
<7> on the numeric keyboard 
is the same as typing '7' on the 
keyboard. 

Application, keypad keys 
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generate control sequences that 
can be used by some 
applications. 

(Use) NumLock, enables or 
disables the NumLock keyboard 
function in respect to the above 
Numeric and Application 
modes: 
"NumLock" checkbox not 
checked, the NumLock key is a 
regular emulation key that has 
been mapped/defined as PF1 
(default) or any other key. The 
NumLock key will not change 
the NumLock keyboard status. 
"NumLock" checkbox checked: 
Numeric Keypad Mode, the 
NumLock key toggles between 
function states: enabling 
numeric keys (when lit) or 
arrow keys (when not lit). 
Application Keypad Mode, the 
NumLock key toggles between 
function states. Enabling 
numeric keys (when lit) or 
application keys (when not lit). 

Cursor coupling Vertical, determines whether 
the user window pans with the 
cursor when the cursor moves 
past the top or bottom border 
of the user window. 

Page, determines if a new page 
appears in the display when the 
cursor moves to a new page. 

Status Line None, displays an emulation 
screen without the status line. 

Indicator, displays the status 
line.

Host Writeable, disaplays the 
status line sent by the host. 

Label Line, displays a status line 
on the top and bottom line of 
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the emulation screen. 

Label Line For ASCII emulations only. 

Displays a status line on the top 
and bottom line of the 
emulation screen. 

IBM Emulations 

 

 

Option Description 

General ID, determines the ID returned 
by the emulation program to 
the host. Make sure you select 
an ID that the host application 
recognizes. 

Unscaled Screen, when this 
parameter is cleared, the 
characters appearing in the 
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work area are scaled. A change 
in the size of the desktop 
causes the fonts to shrink in 
relation to the size of the 
window. Select this parameter 
if you want to disable this 
feature. 

Show Response Time, displays 
the number of seconds that 
elapsed between the time data 
was sent to the host and the 
host response time. 

Cursor Ruler Select Visible to display full-
screen, vertical or horizontal 
lines as a cursor ruler (cross 
hair guide). 

Cross Hair, displays the cursor 
ruler as a horizontal and 
vertical line. 

Horizontal, displays the cursor 
ruler as a horizontal line only. 

Vertical, displays the cursor 
ruler as a vertical line only. 

Cursor Controls the cursor appearance 
and functionality: 

Block/Underline/Visible/Blink, 
controls the cursor appearance. 

Ins Change, when selected it 
enables toggling the cursor 
between underline and block 
appearance, by clicking the Ins 
(insert) button. 

Appearance Power GUI, displays data in a 
window with 3D look & feel. Use 
system fonts larger than 10 pt. 
for optimized results. 

HLLAPI Names The names of an hllapi session 
can either be short or long. 

34 of 93 



  PowerTerm LTC: General Reference 

Short and Long, enables you to 
specify the short and long hllapi 
names. 

Code Page Specifies the host and LTC 
(keyboard) character sets. 

Alternate Size Enable, select to override the 
terminal alternate size with a 
specific size. 

Rows/Cols, type the required 
number. 

2.6.2 Display Property Page 
For non-IBM emulations only. 

 

 

Option Description 
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General Reverse Display Colors, reverse 
the text and background colors 
in the work area. 

Unscaled Screen, when this 
parameter is cleared the 
characters appearing in the 
work are scaled. A change in 
the size of the desktop causes 
the fonts to shrink in relation to 
the size of the window. Select 
this parameter if you want to 
disable this feature. 

Autowrap Characters, wraps 
words at the end of a line and 
the cursor moves to the next 
line. 

History Scroll Bar, displays the 
vertical history scroll bar along 
the right edge of the 
PowerTerm LTC screen. This 
enables you to scroll through 
the data displayed previously 
on the screen. If the host 
transmits during scrolling, the 
display automatically scrolls 
back to its current position. 
NOTE Selecting Clear History 
from the Edit menu erases the 
History buffer. 

Cursor Ruler Select Visible to display full-
screen, vertical or horizontal 
lines as a cursor ruler (cross 
hair guide). 

Cross Hair, displays the cursor 
ruler as a horizontal and 
vertical line. 

Horizontal, displays the cursor 
rules as a horizontal line only. 
Vertical, displays the cursor 
ruler as a vertical line only. 

Cursor Controls the cursor appearance 
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and functionality: 

Block/Underline/Visible/Blink, 
controls the cursor appearance. 

Ins Change, when selected, it 
enables toggling the cursor 
between underline and block 
appearance by pressing the 
Insert key. 

Ctrl Characters Display, displays the control 
characters. 

Interpret, displays normal text 
as affected by control 
characters. 

Power GUI Displays data in a window with 
3D look & feel. Use System 
fonts larger than 10 pt for 
optimized results. 

Show Frame Places a frame around the text 
area of the emulation. 

Dimensions Determines the number of 
characters (columns) per 
displayed line, and the number 
of lines to be displayed in the 
work area. Characters are 
scaled according to the selected 
values. Type a different value in 
the Other box instead of 
choosing one of the standard 
options (80 and 132). 

Scrolling Determines the pace at which 
data is displayed in the work 
area as it arrives. If you select 
Jump, you should determine 
the Jump Scroll Speed that is 
measured in number of line 
units. The higher the value, the 
faster the scrolling. 

Unlimited, displays data without 
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delaying communication. 

Page, scrolls data by full 
screens. 

Smooth, is equivalent to a Jump 
Scroll Speed of 1. 

Enable Soft fonts Enables you to work with VT 
soft fonts. The fonts will be 
loaded from the host 
application. 

2.6.3 Keyboard Property Page 

Non-IBM Emulations 

 
 

Option Description 

Capslock Mode Determines the behavior of the 
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Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 

Backspace Key Sends Delete Determines whether the 
<Backspace> key sends Delete 
or an actual Backspace. 

Auto Repeat Repeatedly sends the character 
whose key is being continuously 
pressed down. 

Key Click Issues a click sound when you 
press a key on the keyboard. 

Warning Bell Determines whether the 
terminal sounds a bell tone 
when receiving the "bell" 
(ASCII 7) character. For 
operating errors, mail 
messages, etc. 

Margin Bell Determines whether the 
terminal sounds a bell tone 
when the cursor reaches the 
right margin. 

Numpad Decimal sends 
Comma 

Specifies that the Numeric 
Pad's decimal key sends a 
comma instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
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key. 

Local Echo Determines whether keyboard 
input is displayed (echoed) on 
your screen. 

Select, to display the keyboard 
input even if the host system 
does not echo your input. 

Clear, to send the keyboard 
input to the host system 
without being displayed on the 
screen (unless the host system 
echoes the characters). 

Use VT Keyboard Mode Changes your keyboard into a 
Digital VT keyboard mode. In 
this mode, the LTC keyboard 
operates as close to a VT 
keyboard as possible, and takes 
full advantage of LK450 Digital 
keyboards. 

Answerback Message Specifies an answerback 
message and its display. 

Clear, deletes the message. 

Conceal, hides the message 
without being deleted. 

Auto Answerback Determines whether the 
terminal automatically sends 
the message to the host system 
after you make the connection. 
This is useful if your 
answerback message is a 
command to the host system. 
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IBM 3270  Emulations 

 
 

Option Description 

Capslock Mode Determines the behavior of the 
Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 
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Backspace Deletes Select to delete characters by 
pressing the Backspace key on 
your keyboard. 

Auto Repeat Repeatedly sends the character 
for which its key is being 
continuously pressed down. 

Key Click Issue a click sound when you 
press a key on the keyboard. 

Lock Numeric Field Determines whether the 
keyboard is locked when you 
try to enter non-numeric data. 

Typeahead Types data ahead, before the 
host responds. 

Automatic reset Key If the Keyboard is locked, a 
reset key sequence is 
generated prior to when you 
click on the tab key to advance 
to the next field. 

Numpad Decimal Sends 
Comma 

Determines whether the 
Numeric Pad sends a comma 
instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
key. 

Non SNA System Wait Determines whether the 
System Wait in the IBM 3270 
emulation will act as a System 
Wait in a non-SNA terminal. 
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IBM 5250 Emulations 

 

 

Option Description 

Capslock Mode Determines the behavior of the 
Caps Lock key. 

Caps (Unix), locks alphabet keys 
on main keypad in uppercase. 

Shift, locks alphabet and 
numeric keys on main keypad 
in shift setting. Pressing the 
shift button on your keyboard 
will release shift-lock mode. 

Reverse (Win), Same behavior 
as Caps Lock, however pressing 
the shift button on your 
keyboard reverses the caps 
operation. 
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Backspace Deletes Select to delete characters by 
pressing the Backspace key on 
your keyboard. 

Auto Repeat Repeatedly sends the character 
for which its key is being 
continuously pressed down. 

Key Click Issue a click sound when you 
press a key on the keyboard. 

Warning Bell Determines whether the 
terminal sounds a bell tone 
when receiving the "bell" 
(ASCII 7) character. For 
operating errors, mail 
messages, etc. 

Typeahead Types data ahead, before the 
host responds. 

Automatic reset Key If the Keyboard is locked, a 
reset key sequence is 
generated prior to when you 
click on the tab key to advance 
to the next field. 

Numpad Decimal Sends 
Comma 

Determines whether the 
Numeric Pad sends a comma 
instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key 
perform the terminal operation 
even if Windows OS has an 
operation mapped to the same 
key. 
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2.6.4 Printer Property Page 

 
 

Option Description 

Print Device Allows you to select a printing 
output channel. 

None, no destination was 
assigned. The Device Name is 
disabled. Printer data is 
received by the terminal, but 
discarded (not printed). 

Device, sends printing to the 
device you designate in the 
Device Name text box. This can 
be a device such as COM1, 
COM2, COM3, etc. in the Device 
Name text box, you can also 
specify communication 
parameters. For example: COM 
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1:9600,8. 

Network, sends printing to the 
network printer. You must hen 
perform the following: 
1. Select File | Print Setup. 
2. Select Network from Port 
field. 
3. Type UNC (Universal Naming 
Convention) in the Net Path. 
For example, \\net1\hp4000

AUX, sends printing to the 
auxiliary port. 

Device Name The available printing devices 
are: LPT1: (default) COM x: 

Use Form Feed Adds a form feed (page eject) 
after each printing job. This 
depends upon the available 
connections on your device. 

Print Line Graphics As Text Converts line graphics to text. 
This speeds up printing on a 
slow dot-matrix printer. 

LF->CRLF Adds a line feed after each 
single carriage return (one that 
has no line feed following it) 
when in slave printing mode. 

Print Screen Data Conversion Converts data to IBM or Digital 
character sets or prints in 
Graphics mode. 

None, does not convert data. 

Slave Printer Data 
Conversion 

Converts data to IBM or Digital 
character sets, or prints in 
Graphics mode for slave 
printing. 

None, does not convert data. 

Slave Printer Job Delimiter For non-IBM emulations only. 
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Specifies the job delimiter 
character that will divide the 
data into print jobs, thus 
disabling the escape sequences 
arriving from the host 
application. 

Delay for Print Closing The command to close the 
printer queue is delayed by the 
number of seconds that you 
determine. This command only 
takes effect if no open 
command is issued in the 
meantime. Important for 
printing to cut sheet printers 
(for example, inkjets/lasers) 
and network printers. 
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2.6.5 Advanced Printing Setup 

 
 

Option Description 

Printer Type Specifies the destination 
printer. 

Margins Specifies the space between the 
edge of the printout page and 
the border of the printing. 

Font Printer default font and size will 
be applied to the output when 
Ignore is selected. Otherwise, 
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User input will be applied. 
Select the desired font from the 
Font dropdown list. 

CPI Character per Inch 

LPI Lines per Inch 

Printer Columns/Rows For graphic printing only. 

Determines the number of 
printer columns/rows in the 
output. Select Ignore to apply 
the number of columns on your 
emulation screen to the output. 

Page Type for Text Printing Specifies the page type (for 
example, A3, A4, A5 etc.) 

Form Feed Defines the form type of the 
printer. PowerTerm LTC 
provides the following three 
types: AUTOCUT, single-cut 
sheets are automatically fed 
into the printer. Most printers 
require a sheet feed 
attachment. CONT, continuous 
sheets are used by printers that 
have a tractor feed attachment 
on the device. CUT, single-cut 
sheets are manually fed into 
the printer. 

Orientation Specifies the orientation of the 
printed output. The default 
depends on your printer' 
settings. Options are: Ignore 
Portrait Landscape. 

Enable AS/400 Host Print 
Transform 

For IBM 5250 printer 
emulations only. 

Enabled, pass through 
(transparent) mode. The host 
sends (ASCII) command and 
text directly to the printer. Non-
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graphic printing only. Disabled, 
the host sends (EBCDIC) 5250 
SCS format commands and text 
to the emulation. The 
emulation, in turn, translates to 
printer specific commands. 

Customizing Object Specifies the object name that 
you have previously defined on 
the AS/400. Enabled only for 
"Other" printer models. 

Library Specifies the customizing 
object's library on the AS/400. 
Enabled only for "Other" printer 
models. 

Drawer 1 Specifies the size for the paper 
in Paper Source 1. 

Drawer 2 Specifies the size for the paper 
in Paper Source 2. 

Envelope Hopper Specifies the size of the 
envelope. 

Supports ASCII Code-Page 
899 

Specifies whether the printer 
has Code Page 899 installed. 

2.6.6 Tabs Property Page 
For VT emulations only. 
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Options Description 

Tabs Stops Click anywhere within the Tab 
Stops area to set tab stops 
manually. 

Set Every Sets a tab stop in increments of 
a number typed in the adjacent 
text field. 

Clear All Clears all tab stops. 
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2.6.7 Colors Property Page 

Non-IBM Emulations 

 
 

Option Description 

Preview Box Shows the result of your 
selections. 

Enable Underline Enables underlined characters. 

Clear to disable displaying data 
with the underline, for data 
transmitted from the host with 
the Underline attribute. 

Enable Blink Enables blinking. 

Clear to disable blinking data, 
for data transmitted from the 
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host with the blink attribute. 

Coloring method dropdown 
list 

Default, uses the default color 
type for each emulation type: 
VT and Siemens – Attribute & 
ANSI colors 
ANSI and HP – ANSI colors 
All others – Attribute colors (i.e. 
not affected by setting to a 
different value). 

Attribute, colors based on the 
attributes. For example, you 
can select different colors for 
bold, for underline, and for 
bold/underline. 

ANSI, colors based on host-
defined colors. For example, 
the host sends "red foreground 
on blue background" however 
you can select the default ANSI 
color. Different attributes do 
not affect colors. 

Attribute & ANSI, uses both 
Attribute and ANSI colors as 
explained above. 

ANSI 8 Color Mode For ANSI emulations only. 

A regular terminal has 16 colors 
(8 colors with the Bold attribute 
applied to them and 8 colors 
without the Bold attribute 
applied to them). The 
Background color never has the 
bold attribute (therefore it is 
"dark") while the Text 
(foreground) is always mapped 
to the color with the Bold 
(bright, light) attribute. 

Non-selected, each entity (text, 
background) can have any of 
the 16 colors mapped to them. 

Selected, each entity (text, 
background) can have any of 
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the 8 colors mapped to them. 

Color Frame Select to draw a color frame on 
the screen. 

Select Attribute Select the attribute for which 
you want to define foreground 
and background colors. 
Attributes change according to 
the emulation type you selected 
in the Connection properties 
dialog. Generally, the attribute 
of the entire screen is Normal. 
The color for the Normal 
attribute determines the color 
of the entire work area. 

Text Select the color that will apply 
to the text (foreground) of the 
display. 

Background Select the color that will apply 
to the background of the text. 
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IBM Emulations 

 
 

Option Description 

Preview Box Shows the result of your 
selections. 

Enable Underline Enables underlined characters. 

Clear to disable displaying data 
with the underline, for data 
transmitted from the host with 
the Underline attribute. 

Enable Blink Enables blinking. 

Clear to disable blinking data, 
for data transmitted from the 
host with the blink attribute. 

55 of 93 



  PowerTerm LTC: General Reference 

Show Column Separator For IBM 5250 emulations only. 

Displays a period as a column 
separator in fields with the 
column separator attribute. 

Color Frame Select to draw a color frame on 
the screen. 

Select Attribute Select the attribute for which 
you want to define foreground 
and background colors. 
Attributes change according to 
the emulation type you selected 
in the Connection properties 
dialog. Generally, the attribute 
of the entire screen is Normal. 
The color for the Normal 
attribute determines the color 
of the entire work area. 

Text Select the color that will apply 
to the text (foreground) of the 
display. 

Background Select the color that will apply 
to the background of the text. 
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2.6.8 Preferences Property Page 

 
 

Option Description 

On Terminal Setup File Open Auto Connect, establishes a 
connection immediately with 
the parameters saved in the 
terminal parameters file. 

Show Connect Dialog Box, does 
not establish a connection 
immediately, rather the 
Connect dialog opens and 
enables you to select required 
connection. 

Do not Connect, opens only the 
PowerTerm window. 

Window Title Specifies a customized name 
that appears on the title bar. 
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History Buffer Specifies the size of the buffer 
in which data is stored, by 
selecting an option from the 
dropdown list. 

On PowerTerm Exit Save Terminal Setup, the new 
terminal parameters (if you 
changed them during the 
session) are saved to the 
current terminal setup file. 

Confirm Save, terminal 
parameters are not saved 
automatically. PowerTerm LTC 
displays a dialog where you can 
decide whether or not to save 
any changes you did to the 
settings during the session. 

Save Window Size & Position, 
saves the size and position of 
the emulation window. The next 
time you open PowerTerm, the 
window appears with the 
desired size at the set position. 

Confirm Disconnect Session, if 
you close PowerTerm LTC 
during a session, you will be 
required to confirm disconnect. 

Inactivity Timeout, specifies the 
time limit for keyboard 
inactivity, after which 
PowerTerm LTC shuts down. 

On Session Exit Auto Reconnect, re-establishes 
communication if the line was 
disconnected. 

Auto Exit PowerTerm LTC, closes 
PowerTerm LTC altogether on 
disconnect. 
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2.7 Security Settings Dialogs 
2.7.1 SSL Security 

In the SSL Security Setup dialog you can specify what Certificates you 
accept and their path. 

 

2.7.2 SSH Security 
In the SSH Security dialog you can specify what type of SSH properties you 
require. 
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2.7.3 Kerberos Security 
In the Kerberos Security dialog you can configure Kerberos parameters. 
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You can also perform more advanced Kerberos actions in the Kerberos 
Manager dialog. 

 

 

Menu Description 

Actions Change Password 

Refresh 

Tickets Get, opens the Kerberos Login 
dialog where you can request to 
get tickets. 

Delete, removes all the Kerberos 
Tickets. 

Renew, enables you to prolong 
time limited tickets. 

Options Realm Configuration, opens the 
Realm configuration dialog 
where you can specify with 
which domain your computer is 
associated. 
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3 Starting and Stopping Sessions 
When PowerTerm LTC is used for the first time, the PowerTerm LTC window 
is automatically displayed together with the Connect dialog. After the 
connection parameters have been defined, the Connect dialog will be 
displayed according to your selected options. 

You can determine PowerTerm LTC behavior and automate processes in the 
Preferences property pages. These remain active until you change them. For 
example, if you select to connect automatically at PowerTerm LTC startup, 
you will always be connected when you open PowerTerm LTC. Other 
behaviors you can customize are for example auto-reconnect and keyboard 
inactivity time limit. 

PowerTerm LTC opens with the default terminal setup file. You can also open 
PowerTerm LTC using a customized setup file, or a script file. 

Once you have defined terminal and communication parameters, you can 
then connect to a host. For more information on connections, see chapter 
Defining Connections. 

The communication mode appears beside the application name on the 
PowerTerm LTC window title bar. When communication ends, the mode 
name disappears from view. 

When working with more than one host, PowerTerm LTC enables you to 
connect to a host using customized PSL scripts. You need to define a 
different script with the name of each host. For more information about 
scripts, see chapter Scripts. 

PowerTerm LTC also provides the option to modify connection parameters 
for COM type communications. This option is only available once you are 
connected to a host. 

 To define preferences: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. The Preferences property page is displayed. 

3. Select the parameters that you require. 

3.1 Starting PowerTerm LTC Using a Setup File 
PowerTerm LTC can be started using a default or customized setup file. A 
setup file contains both communication session parameters and terminal 
setup parameters. It is in text format and can be edited using a text editor. 

The Default Setup file, called ptdef.pts, is used with single host connections. 
When you open PowerTerm LTC, it automatically uses this file to initiate 
terminal setup and connection parameters. 
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A customized setup file is used with multiple host connections and when you 
want to start PowerTerm LTC with predefined communication and terminal 
setup parameters for a specific connection. 

 To use a setup file during PowerTerm LTC session: 

A terminal setup file can also be opened during a PowerTerm LTC session to 
run a session using predefined terminal setup and communication 
parameters. There are two options to use a setup file: 

• Select File | Open Terminal Setup. The Open File dialog appears in which you 
can select a setup file. 

• Select Communication | Connect. The Connect dialog appears in which you 
can specify the name of the setup file to be run before communication is 
established. 

3.2 Starting PowerTerm LTC Using a Script 
You can also launch PowerTerm LTC and run a script immediately upon 
launching. Scripts are created with PowerTerm LTC Script Language (PSL) 
and enable you to automate tasks. For example you can use a script to 
automatically connect to a specific host. 

3.3 Starting PowerTerm LTC with Auto Connect 
The Auto Connect option enables you to automatically connect to a specific 
terminal using the parameters in the default setup file. 

 To access the Auto Connect option: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Preferences tab. The Preferences Property page is displayed. 

3. Select Auto Connect. 

4. Click OK. 

3.4 Starting a New PowerTerm LTC Session 
PowerTerm LTC enables you to run two or more sessions concurrently by 
opening a new instance of the PowerTerm LTC window. Each session is 
identified by a letter (starting with A), which appears in the session window 
title bar. A session is assigned the first available letter. For example, if A, B 
and D are opened the next session opened is assigned C. 

 To open a new instance of the PowerTerm LTC window: 

Select File | New Terminal Window. A new instance of the PowerTerm LTC 
window opens. 

 To toggle between open sessions: 

Press <Ctrl>+<Spacebar>. 
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 To switch to a specific session: 

You can either: 

• Press <Shift>+<Ctrl>+<X>, where X is the session letter. For example, if you 
want to work in session C, you would press <Shift>+<Ctrl>+<C>. 

3.5 Ending a PowerTerm LTC Session 
You need to end the session(s) before exiting the PowerTerm LTC 
application. There are a few options to end a session: 

• Automatic closing - PowerTerm LTC enables you to close PowerTerm LTC 
automatically when you close a session. If you have modified terminal 
parameters during a session, a message displays asking if you want to save 
the setup file before closing. 

• User-initiated closing – Manually closing a session at any time. 

• User-initiated fast exit – Sometimes you require a fast exit while 
communication is in progress. PowerTerm LTC then reacts according to the 
parameters selected in the Preferences property page in the Terminal Setup 
dialog. 

You also have the options such as to require a confirmation when closing 
PowerTerm LTC during a session and to immediately re-connect again, 
automatically or manually (for non-IBM emulations only). 

 To manually close a session: 

Select Communication | Disconnect. 

 To exit PowerTerm LTC: 

1. Select File | Exit. If you have changed the terminal settings, PowerTerm LTC 
displays a warning message asking if you want to update the terminal 
settings file. The message will point to the name of the setup file currently 
loaded. 

2. Click OK to update the file, or NO to cancel the latest changes and restore 
the original settings of the current setup file. 

 To fast exit the current session: 

Press <Alt>+<F4> on the keyboard. 

 To confirm disconnect: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab.  

3. Select Confirm Disconnect Session.  

4. Click OK. 

 To define parameters for automatic closing PowerTerm LTC when 
disconnecting a session: 

Close PowerTerm LTC altogether on disconnect. 
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1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Exit PowerTerm LTC in the On session exit section. 

4. Click OK. 

 To manually reconnect to a PowerTerm LTC session after exiting the 
current session: 

PowerTerm LTC displays the following message at session termination when 
Auto Exit PowerTerm LTC in the Preferences tab is cleared: 

 

where <exit code> may have one of the following values: 

Zero (0) Communication ended 
successfully. 

Any number (other than 0) Communication aborted. The exit 
code points to the error that 
caused the problem. 

Press Enter on the keyboard.  

 To automatically reconnect a PowerTerm LTC session after exiting the 
current session: 

Re-establish communication if the line was disconnected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Reconnect in the On Session Exit section. 

4. Click OK. 

 To specify keyboard inactivity timeout: 

Specify the time limit for keyboard inactivity, after which PowerTerm LTC 
shuts down. 
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1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Enter the amount of minutes for Inactivity Timeout. 

4. Click OK. 
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4 Defining Emulations 
PowerTerm LTC enables you to define the terminal settings for connecting to 
a host. Once you have defined terminal settings, you can save them as a 
setup file. This file can be activated at startup or opened manually during a 
PowerTerm LTC session. You first have to select an emulation type and then 
define the other settings. 

The Emulation property page displays the emulation terminal types available 
with your version of PowerTerm LTC. The emulation type that you select 
changes the tabs (property pages) displayed in the Terminal Setup dialog. 
Some emulation types also change the look of the PowerTerm LTC desktop. 
For example, for IBM 3270 and 5250 terminal types the work area is black 
and the toolbar contains fewer icons. 

The General property page enables you to define parameters for the selected 
emulation type, such as: 

• The ID returned by the emulation program to the host. 

• Communication and keyboard character sets for both 7-bit and 8-bit data. 

• The behavior of the <Enter> key. 

• Whether applications on the host system can override your user-defined 
keys (UDKs). 

• Determines the effects of the numeric keypad on your keyboard. (VT 
emulations only.) 

 The selected host application will usually determine the default option. 

 To define emulation parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. The Emulation property page is displayed. 

3. Select the terminal type that you require from the list of supported 
emulations. 

4. Select the General tab. The General property page is displayed. 

5. Select the emulation parameters you require. 

6. Click OK. 

General parameters 

 To define host's ID response: 

In the General tab, select Terminal ID from the dropdown list. 

 To specify type of Cursor coupling: 

In the General tab, select Vertical to move the cursor past the top or bottom 
border of the user window, or Page to move the cursor to a new page. 
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Non-IBM specific parameters 

 To define communication and keyboard character set: 

The available character sets change according to emulation type selected. 

In the General tab, select the NRC/UPS set required from the dropdown list. 

 To prevent the host to override your function keys: 

In the General tab, select User Defined Keys Locked. 

 To set the terminal to be online/offline: 

In the General tab, select or clear Online. 

 To define the Enter key behavior: 

In the General tab, select New Line. 

IBM specific parameters 

 To define scaled/unscaled screen: 

In the General tab, select or clear Unscaled Screen. 

 To display host response time: 

In the General tab, select Show Response Time. 

 To define cursor appearance: 

In the General tab, select if you want a Block or Underline display. 

 To define GUI appearance: 

In the General tab, select Power GUI or Show Frame to display a "different" 
look of the work area. 

 To define the code page: 

In the General tab, select Host and PC Code Pages in the dropdown lists. 

 To specify the alternate size: 

In the General tab, select Enable and enter the Rows and Cols (columns) 
sizes. 

VT specific parameters 

 To define the numeric keypad mode: 

The Num Lock key toggles between numeric keys or arrow keys. 

In the General tab, select Numeric and Numlock. 

 To define the application keypad mode: 

The Num Lock key toggles between numeric keys or application keys. 

In the General tab, select Application and Numlock. 
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WYSE specific parameters 

 To show a status line: 

Specify if you want your session's or the host's status line. 

In the General tab, select Indicator or Host Writable. 

 To show the label line: 

Display a status line at the top and the bottom of the emulation screen. 

In the General tab, select Label Line. 
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5 Defining Connections 
You can create different connections according to your needs. The 
connection parameters that you define will remain active only for the current 
session, unless you save them. 

After you saved your connection, you can modify its parameters. 

The default setup name is the name of the connection. 

You can also delete connections that are no longer in use. 

 To define a connection: 

 

1. Select Communication | Connect. The Connect dialog appears. 
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2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run upon 
connection. 

6. Click Connect. 

 To specify SSL Security parameters: 

Select SSL in the Security Type dropdown list and select required SSL 
version. 

 To specify SSH Security parameters: 

1. Select SSH in the Security Type dropdown list and click Details. The SSH 
Security dialog is displayed: 

 

2. Select the desired SSH Version. 

3. Specify the SSH properties. 

4. Click OK. 
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 To specify Kerberos Security parameters: 

1. Select Kerberos in the Security Type dropdown list and click Details. The 
Kerberos Security dialog is displayed: 

 

2. Specify User ID and select the desired options. 

3. Click OK. 

 To save a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run upon 
connection. 

6. Click Save As. The Save Session dialog appears. 

7. Enter a Session Name and click OK. The connection is displayed in the 
Sessions List. 

 To use an existing configuration: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Connect. 

 To modify connection parameters: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 
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3. Make desired changes in the parameters. 

4. Click Modify. 

 To rename a session: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Rename. The Rename Session dialog appears. 

4. Enter a new Session Name and click OK. 

 To delete a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Delete. A confirmation notification is displayed. 

4. Click OK. The connection is deleted. 
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6 Manipulating the Desktop and Selecting 
Text 

PowerTerm LTC enables you to customize the PowerTerm LTC window by 
displaying or hiding desktop components and changing the display colors for 
different text attributes. The color attributes change according to the 
emulation type you have selected. 

This chapter also presents specific text selection techniques that you may 
find useful in different emulations. 

6.1 Manipulating Desktop Components 
Most components are displayed or hidden according to your selection in the 
Options menu. 

 To show/hide the Menu bar: 

• Select Options | Hide Menu. This conceals the Menu bar. 

• Map a Soft button with the following PSL command: 

menu restore 

to use for restoring the Menu bar. 

 To show/hide the Soft buttons: 

• Select Options | Hide Buttons. The menu option becomes Show Buttons. 

• Select again to redisplay the Soft buttons bar. 

 To show/hide the Status bar: 

• Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 

• Select again to redisplay the Status bar. 

 To show/hide the History Scroll bar: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select or clear History Scroll Bar in the General section. 

4. Click OK. 

6.2 Manipulating Desktop Display 
You can customize your desktop display in numerous ways, for example 
change colors of background and/or text, change the cursor display, change 
the work area dimensions, as well as select fonts and GUI language. 
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 To change the GUI language: 

• In the Terminal menu, select the desired language. 

6.2.1 Setting Fonts 
PowerTerm LTC enables you to use standard system fonts or select special 
PowerTerm LTC fonts to be displayed in the PowerTerm LTC window. 

• System fonts are standard general-purpose fonts, which different attributes 
can be set. 

• PowerTerm LTC fonts are scaleable fonts, automatically calculated according 
to the screen size of the host application. 

 To work with PowerTerm LTC fonts: 

Select Terminal | PowerTerm LTC Fonts. The PowerTerm LTC window will now 
display PowerTerm LTC fonts. 

 To work with system fonts: 

1. Select Terminal | System Fonts. The Font dialog appears. 

2. Select the font, style, and size as you desire. 

3. Click OK. The PowerTerm LTC window will now display the selected system 
font. 

 To work with VT soft fonts: 

For VT emulations only. 

The fonts will be loaded from the host application. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Enable soft fonts. 

 To lock font size: 

Characters appearing in the work area are scaled and their size will change 
proportionally when changing the desktop size. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select Unscaled Screen to lock the font size 

 To wrap words at the end of a line: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Autowrap Characters. 
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6.2.2 Setting Color 
 To change the display color of the PowerTerm LTC window: 

The color for the Normal attribute determines the color of the entire work 
area. The box above the Select Attribute parameter shows the result of your 
selections. The Select Attribute of the entire screen is generally Normal for 
non-IBM emulations. 

1. Select Terminal | Setup. The Terminal Setup dialog is displayed. 

2. Click the Colors tab. The Color property page is displayed. 

3. Select the attribute for which you want to define foreground and background 
colors. Notice that the attributes change according to the emulation type you 
selected previously. 

4. In the Text area, select the color that you want to apply to the text 
(foreground) of the display. 

5. In the Background area, select the color that you want to apply to the 
background of the text. The preview box above the Select Attribute 
parameter shows the result of your selections. 

6. Click OK. 

 To reverse display colors: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Reverse Display Colors. 

 To specify ANSI/Attribute colors: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select your preference in the Default Colors drop down list. 

6.2.3 Setting work area 
 To specify dimensions of screen: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want 80 or 132 Columns or enter your own number of columns 
in Other. 

4. Select how many Lines per screen you want, from the dropdown list. 

5. You can also specify if you want to Limit the font size so only optimal font size 
will be used. (Relevant when working with PowerTerm fonts only.) 
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 To change the appearance of the PowerTerm LTC window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select Power GUI or Show Frame as desired.  

 To specify pace at which data is displayed: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want Smooth or Jump scrolling. 

4. Select Jump Scroll Speed from the dropdown list. 

 To set tabs in the work area: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Tabs tab. The Tabs property page is displayed. 

3. Click in the ruler where you want to set a tab. A 'T' will appear. 

4. Click the 'T' to clear it. 

5. You can also specify a certain interval between the tabs by entering a 
number and then click Set Every. 

 To set coursor coupling: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Vertical and/or Page for when the cursor moves past the top or 
bottom border of the user window or to a new page respectively. 

 To display a cursor ruler: 

4. Select Terminal | Setup. The Terminal Setup dialog appears. 

5. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

6. Select Visible to display the cursor ruler. 

7. Select Crosshair/Horizontal/Vertical appearance of the cursor ruler. 

 To change cursor appearance: 

For IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General tab for IBM 
emulations. 

3. Select in Cursor the desired appearance. 
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4. Select Ins Change to enable toggling the cursor between underline and block 
appearance. 

 To display the status line in the emulation window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select desired option in the Status Line dropdown list. 

 To display the Labels line in the emulation window: 

For WYSE emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Labels Line. 

 To show host response time: 

For IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Show Response Time. 

 To disable/enable underlined data: 

If data is transmitted with the underline attribute, you can disable the 
underline by clearing this parameter. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Underline as desired. 

 To disable/enable blinking data: 

You can choose whether to enable blinking of data, which was received from 
the host with the blinking attribute. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Blink as desired. 

 To set column separator: 

For IBM 5250 emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select Column Separator. 
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6.3 Selecting Text 
General selection techniques 

 To select a word: 

In the work area, just click a word to select it. 

 If the Automatic Copy option in the Edit menu is active (default), selecting 
text also copies the selection to the clipboard. 

 To select full lines: 

Point to a line, hold down the <Shift> key on the keyboard and drag the 
mouse to the last line you want to include in the selection. 

 To select a string: 

Point to the first character that you want to include in the selection. Drag 
the mouse to the last character that you want to include in the selection and 
release the mouse button. 

 To select the entire screen: 

Select Edit | Select Screen. 

VT emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block, hold down the <Ctrl> key on the keyboard 
and drag the mouse to the opposite corner of the block you want to include 
in the selection. 

 To select a menu entry: 

Double-clicking on a word sends that word to the host once you have 
pressed <Enter> on the keyboard. Use this feature to select a menu entry. 
For example, if the emulation screen displays the menu of an application 
residing on the host, click a menu entry to activate the program that the 
menu entry represents. 

IBM emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block and drag the mouse to the opposite corner 
of the block you want to include in the selection. 

 To activate light pen support: 

For IBM 3270 emulations. 
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Any double-click on the screen is equivalent to touching the screen with a 
light pen. 
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7 Keyboard Settings 
PowerTerm LTC enables you to map LTC keys to host keys in order to 
emulate the host terminal keyboard. The keyboard mapping definitions are 
stored in a file with the same name as the current terminal setup file, with 
the extension .ptk. For example, the default keyboard mapping definitions 
are stored in a file called ptdef.ptk. 

You can also modify your keyboard to behave in certain ways such as having 
the Backspace key send either backspace or delete, or letting the Numpad 
send a comma. 

7.1 Mapping Keys 

 

 To wiew the keyboard mapping: 

1. Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 

2. Slide the mouse pointer over the different keys. The bottom line of the 
dialog shows you the corresponding LTC and terminal keys. For example, if 
you point to the "t" key of the VT keyboard, you see that the corresponding 
LTC key is "T". 
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 To map a LTC key: 

• Drag a key from the upper terminal keyboard to a LTC key on the lower 
keyboard. 

• Click the <Shift> or <Ctrl> keys on the terminal keyboard to display additional 
key functions. For example, if you click the <Shift> key, the alphabet keys 
on the terminal keyboard are displayed in upper case. You can then map 
(drag) these keys to your LTC keyboard keys. 

 To assign a script command to a LTC key: 

1. Right-click a key on the LTC keyboard that you want to assign a command 
and select Enter Script Commands. The PC Button dialog appears. 

2. Enter the desired script command and click OK. The LTC key has now been 
assigned a script command. 

 To map combinations of keys that include Alt, Ctrl, and Shift: 

• Click the <Alt>, <Ctrl> or <Shift> key (or any combination of them) on your 
LTC keyboard. Then map keys by following the procedure described 
previously. 

• Click the required <Alt>, <Ctrl> or <Shift> key (or any combination of them) 
to view the mapped keys. 

 To cancel a key definition: 

Drag the LTC key definition that you want to cancel to . This restores 
the default function of the LTC key. 

 To replace a LTC key with another LTC key: 

PowerTerm LTC enables you to move the functionality of a mapped LTC key 
to another LTC key. For example, you can drag the F6 key on the LTC 
keyboard to the spacebar on the LTC keyboard to give it F6 functionality. 

• Drag the desired LTC key onto the LTC key that it will replace. The 
functionality of the LTC key has been replaced. 

• Drag the original key back to its initial position to restore the values. 

 To copy a LTC key to another LTC key: 

PowerTerm LTC enables you to copy the functionality of one LTC key to 
another LTC key. 

1. Select the LTC key whose function you want to copy to the required LTC key 
and right-click Copy. 

2. Select the LTC key to where you want to copy the function and right-click 
Paste. Both keys now have the same functionality. 

 To restore the default keyboard mapping of all mapped keys: 

Click Defaults in the Keyboard Mapping dialog. 
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7.2 Saving and Opening Keyboard Mapping Settings 
PowerTerm LTC enables you to save keyboard-mapping settings separately 
and open them at a later date.  

 To save keyboard mapping settings: 

1. Select File | Save Keyboard File. The Save Keyboard File dialog is displayed. 

2. Enter a File Name. 

3. Click Save. 

 To open a predefined keyboard mapping settings: 

1. Select File | Open Keyboard File. The Open Keyboard File dialog is displayed. 

2. Select the required keyboard settings from the list. 

3. Click Open. Parameters defined in the selected keyboard settings are now 
applied to the current session. 

7.3 Keyboard Behavior 
You can customize your keyboard. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select the behaviors you desire and click OK. 

 To enable alphabet keys lock in uppercase: 

4. Select Terminal | Setup. The Terminal Setup dialog appears. 

5. Click the Keyboard tab. The Keyboard property page is displayed. 

6. Select Caps (Unix). 

 To lock alphabet and numerick keys in shift setting: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Shift. 

 To reverse the Caps Lock: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Reverse (Win). Pressing Shift on your keyboard reverses the caps 
operation. 

 To set the Backspace key: 

The Backspace key can either send Delete or an actual Backspace. 

1. Select Terminal | Setup and click the Keyboard tab. 
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2. Select or clear Backspace Key Sends Delete as you desire and click OK. 

 To automatically repeat a character: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Auto Repeat and click OK. The character will display repeatedly when 
you continuously press its key on the keyboard. 

 To set sounds: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Key Click to issue a click sound when you press a key on the 
keyboard. 

3. Select Warning Bell to issue the terminal's "bell" character (Ascii 7). 

4. Select Margin Bell to issue a bell tone when the cursor reaches the right 
margin. 

5. Click OK. 

 To set the effects of the numeric keypad: 

For VT emulations only. 

1. Select Terminal | Setup and click the General tab. 

2. Select Numeric if you want the keypad to insert numbers. 

3. Select Application if you want to generate control sequences. 

4. Select or clear Numlock to set the NumLock key behavior:  
Cleared, the NumLock behaves as a regular emulation key. It will not change 
the NumLock keyboard status. 
Selected, the NumLock will toggle between function states, enabling either 
numeric keys or arrow keys. 

5. Click OK. 

 To set the numpad decimal: 

The numeric pad's decimal key can send either a decimal or a comma. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select or clear Numpad Decimal Sends Comma as you desire and click OK. 

 To use emulator Alt key: 

Let the <Alt> key perform the terminal operation even if the OS has an 
operation mapped to the same key. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use Emulator Alt Keys and click OK. 

 To display keyboard input: 

Display the keyboard input even if the host system does not echo your 
input. The input will not be displayed if this option is cleared unless the host 
system echoes the characters. 
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1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Local Echo and click OK. 

 To set an LK450 Digital keyboard: 

For non-IBM emulations only. 

Change your keyboard to work in Digital VT keyboard mode. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use VT Keyboard Mode and click OK. 

 To display an answerback message: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Specify your desired Answerback Message. 

3. Clear to delete the message. 

4. Conceal to hiding the message without erasing it. 

5. Select Auto Answerback to let the terminal automatically send the message 
to the host system. 

6. Click OK. 

 To lock numeric fields: 

For IBM 3270 emulations only. 

Lock the keyboard to avoid entering non-numeric data. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Lock Numeric Fields and click OK. 

 To unlock numeric fields: 

For IBM 3270 emulations only. 

You can enter non-numeric data in numeric fields in two ways. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Lock Numeric Fields twice so it becomes selected but grayed out. Non-
numeric data can be typed in the field only if <Shift> is pressed at the same 
time. 

3. Clear Lock Numeric Fields. All data can be typed in the field. 

 To type ahead: 

For IBM emulations only. 

Continue to type data before the host responds. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Typeahead and click OK. 
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 To set automatic reset: 

Generate a reset key sequence prior to advance to the next field. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Automatic Reset Key and click OK. 

 To set SNA system wait: 

For IBM 3270 emulations only. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Non SNA System Wait and click OK. 
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8 Soft Buttons 
Along the bottom of the PowerTerm LTC window are twelve programmable 
Soft buttons, by default named from F1 to F12. These can be renamed and 
programmed to execute customized scripts or to send individual commands 
to the host. For example, clicking the F1 Soft button is equivalent to sending 
F1 to the host. 

Soft buttons settings are saved automatically in the terminal setup file. 

 To program Soft buttons: 

1. Right-click the Soft button that you want to program. The Function Button 
dialog is displayed: 

 

2. Enter the Function Description (the new name that will appear on the 
button). 

3. Enter a Script Command, or script commands separated by semicolons. 

4. Click OK. The Soft button is now displayed with its new name. Clicking on it 
will execute the newly defined script command.  
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9 Printing 
PowerTerm LTC enables you to define print parameters and print the 
terminal screen or data transferred from the host application. 

The Printer property page and Advanced Printing setup dialogs enables you to 
define printing parameters. 

Printing can be done in Text mode or in Graphic mode, as well as in Host 
and UTF-8 data conversion. For IBM 5250 printing emulations, Host printing 
is enabled. 

There are two different modes with different fields enabled: 

• Text mode is designated in the Printer property page by setting the two data 
conversion combo boxes (Print Screen and Slave Printer) to None. 

• Graphics mode is graphic printing. It is designated in the Printer property 
page by setting the two data conversion combo boxes (Print Screen and 
Slave Printer) to Graphics. 

 To define a printer and set printer parameters: 

1. Select File | Print Setup. The Print Setup dialog appears with a set of printing 
parameters. The displayed parameters change according to the printer you 
select. For details, consult your printer documentation. 

2. Specify desired printer parameters and click OK. 

 To print accumualted data displayed in the work area: 

1. Select File | Start Auto Print. The Start Auto Print command starts 
accumulating incoming data while it is displayed on the screen, and the 
menu option changes to Stop Printing. 

2. Select File | Stop Printing. The Stop Printing command prints all the data 
accumulated in the printing buffer of the slave printer, or in the auto print 
buffer. If data was buffered with a printing request and communication 
failed before the data was sent to the slave printer, select this command to 
print the accumulated data. 

 To manually close the print queue: 

Select File | Close Print Queue. 

 To print the terminal screen: 

1. Mark desired text or the entire contents of the work area. 

2. Select File | Print Screen or click . 

 To define printing parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 
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3. Select the parameters that you require. 

 To define advanced printer parameters: 

Ignore, when selected, applies default values. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Click Advanced Printing. The Advanced Printing Setup dialog appears. 

4. Select the parameters that you require.  

 To select a device or network to be the printing output channel: 

 When Graphics is selected for Print Screen Data Conversion/Slave Printer 
Data Conversion, the Print Manager is automatically used as the printing 
output channel with no regards to which Print Device has been selected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list select Device, 
File, or AUX. 

3. Enter your print communication port in the Device Name field and click OK. 

 To add a form feed after each printing job: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Use Form Feed. 

 To add a line feed after each carriage return: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select LF->CRLF. 

 To convert line graphic to text: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Print Line Graphics as Text. 

 To specify the job delimiter character: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Slave Printer Job Delimiter. 

 To delay print closing: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Delay for Print Closing. 

 To set values for IBM 5250 (AS/400) host print transform: 

The host sends (ASCII) command and text directly to the printer. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 
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3. Click Advance Printing. The Advanced Printer Setup dialog appears. 

4. Select Enable AS/400 Host Print Transform and select the parameters you 
require. 

 To change printing orientation: 

Default orientation depends on your printer's settings. The options are: 
Ignore, Portrait and Landscape. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advance Printing. The Advanced Printer Setup dialog appears. 

4. Select desired Orientation in the dropdown list. 

 To specify printing tray: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

4. Select desired Tray in the dropdown list. 

 To specify printing margins: 

Printout margins are the space between the edge of the printout page and 
the border of the printing. Margins of the print output can be customized 
according to your specific needs. Modifying the top and left margins will 
determine the position at which printing will begin. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Set the Data Conversion Type to Graphics. 

4. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

5. In the Margins field, type your requirement. For example, to shift the margin 
1 cm type in 100. 

6. Select Auto/Auto (Printer Sizes) for the CPI value to enable the right margin 
field. 

7. Select Auto/Auto (Printer Sizes) for the LPI value to enable the bottom margin 
field. 

 To set an LU/Device name: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. From the Emulation tab, select either IBM 3270 or 5250 Display, and click OK. 

3. Select Communication | Connect. The Connect dialog appears. 

4. Select your Session Type and enter the IBM Host Name. 
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5. In the LU/Device Name field, specify the device name for the emulation 
session. The maximum length of the assigned LU name is 8 characters, 
while that of Device name is 10 characters. 
When using multiple sessions, enter a plus sign (+) after the name (e.g. 
John+) and each session will automatically be assigned a new name (John1, 
John2, etc.). 
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10 Scripts 
PowerTerm LTC enables you to create scripts for automating tasks. For 
example, you can create a script to login to a PowerTerm LTC session, 
execute a file, display a message, etc. Scripts can be run upon startup or 
during a PowerTerm LTC session. They can be written in any standard text 
editor and are saved with a .psl extension. This chapter describes how to 
create, edit, run, save and activate script in PowerTerm LTC. 

The PowerTerm LTC Script Language (PSL) is PowerTerm LTC's own 
programming language. For a full description of the different PSL 
commands, see the "PowerTerm Script Language Reference". 

PowerTerm LTC provides the following script options: 

• Record a Script, creates a script by recording all the actions that you 
perform in the PowerTerm LTC window. 

• Run Scripts, runs specific scripts or individual commands, upon startup, 
connection to a host, or during a PowerTerm LTC session, to automate 
specific tasks. You can only run saved scripts. 

• Activate a Recorded Script, executes a non-saved script from the current 
memory. 

• Save a Recorded Script, saves your script to be used at a later date. 

• Assign Scripts, to the Soft buttons. 

 To record a script: 

1. Select Script | Start Script Recording or click . Your actions start to be 
recorded and the menu option changes to Stop Script Recording. 

2. Perform the manual operations that you want to record. For example, select 
a menu option, enter parameters in a dialog, or type a password. 

3. Select Script | Pause Script Recording if you do not want to record certain 
operations. The script recording process pauses and the menu option 
changes to Continue Script Recording. 

4. Select Script | Continue Script Recording to resume the recording. 

5. Select Script | Stop Script Recording or click  when you have performed 
all the operations to be stored in the script. You can also save the script that 
you just created, so that you can run it at any time to repeat the operations. 

 To activate a recorded script: 

• Select Script | Activate Recorded Script (<Alt>+<F9>). The script currently 
recorded in memory is now activated. 

 To save a recorded script: 

1. Select Script | Save Recorded Script. The Save Recorded Script dialog appears. 
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2. Enter a script name. 

3. Click OK. The script will be saved with the specified name 

 To run a specific script: 

1. Select Script | Run Script. The Run Script dialog, which lists all the saved 
scripts, appears. 

2. Double-click the script that you want to run. The selected script is executed. 

 To run individual script commands: 

1. Select Script | Script Command. The Script Command dialog appears. 

2. Type the name of the script command you want to run. Include parameters 
if necessary. 

3. Click OK. The specified script command is executed at once. 

 To run a script file upon connecting to a host: 

1. Select Script | Run Script. The Open Script Setup dialog appears. 

2. Select the desired file. 

3. Click OK. The designated script is executed upon connection. 

 To run a script file during a PowerTerm LTC session using Soft buttons: 

• Click the Soft button that has the desired script assigned. The script is 
executed. For more information, see chapter Soft Buttons. 
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